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Is presented experience one of the most successful tools for the development and drafting of items for import into Moodle. 
 
 
1. Facilităţi şi avantaje oferite de şablon 
Sistemul Moodle (Modular Object-Oriented Dynamic Learning Environment) suportă diferite formate  

de descriere a testelor: Aiken, Blackboard, Course Test Manager, GIFT format with images, Hot Potatoes, 
Moodle XML, WebCT şi altele.  

Formatul GIFT cu imagini este unul dintre cele mai potrivite, deoarece pentru el a fost creat un şablon 
MS Word GIFTTemplate.dot [1] îmbunătăţit, care permite pregătirea itemilor în MS Word, exportarea în 
format GIFT şi importarea în Moodle. 

Şablonul GIFT a fost îmbunătăţit prin adăugarea posibilităţii de introducere a categoriilor, înlăturarea 
unor erori şi elaborarea prezentelor recomandări de utilizare. 

Pregătirea itemilor utilizând GIFTTemplate.dot oferă o serie de avantaje:  
1. Itemii pot fi pregătiţi pe orice calculator autonom, care nu este conectat la Internet.  
2. MS Word permite controlul şi corectarea erorilor ortografice. 
3. Devine posibilă pregătirea sincronă facilă a itemilor în câteva limbi prin simpla traducere. 
4. Exportul din Word în GIFT şi importul din GIFT în Moodle este rapid şi, ca urmare, poate asigura o 

securitate sporită a unor itemi prin instalarea lor doar în timpul testării. 
5. Itemii unui întreg curs, ce constă din diferite module, teme, obiective şi care conţine diferite tipuri de 

itemi, pot fi combinaţi într-un singur fişier, cu gruparea în categorii ierarhizate.  
6. Prezenta versiune a şablonului suportă introducerea unor pictograme/imagini în enunţuri şi în variantele 

de răspuns, ceea ce permite compunerea uşoară a itemilor pentru diverse produse software.  
7. Utilizarea MS Word permite accelerarea procesului de pregătire a itemilor, în special când este vorba 

de un număr mare de itemi similari sau de acelaşi tip, inclusiv prin memorarea itemilor în clipboard şi 
apoi copierea repetată a lor cu modificarea ulterioară, formatarea cu Format painter  etc.  

Şablonul GIFT susţine itemi cu variante multiple de răspuns, itemi binari (adevărat/fals), itemi cu răspuns 
scurt, itemi cu coordonare, itemi de tip eseu/descriere, itemi numerici şi itemi cu cuvinte lipsă. 

Formatul GIFT îmbunătăţit susţine, de asemenea, introducerea numelui/codului itemului, a comentariilor 
la variantele de răspuns, amestecarea sau neamestecarea variantelor de răspuns, atribuirea procentajului de 
evaluare în cazul itemilor cu răspuns multiplu ş.a.  

2. Tehnologia creării itemilor cu GIFTTemplate.dot  
Pentru a utiliza acest instrument de creare a itemilor, e necesar:  
1. Să creăm un fişier Word pe baza şablonului special GIFTTemplate.dot şi să introducem în acest fişier 

itemii.  
2. Să exportăm (convertim) itemii de testare în format GIFT (cu ajutorul comenzii de exportare din şablon). 

Ca rezultat, se salvează o arhivă .zip, în care se află un fişier .txt cu itemii transformaţi în format GIFT 
şi o mapă cu figurile din documentul exportat.  

3. Să importăm itemii din formatul GIFT într-un curs, utilizând comanda de Import a itemilor din Moodle.  
Deschidem fişierul şablon GIFTTemplate.doc, unde se vor afişa câteva mostre de itemi. Exemplele pot fi 

şterse şi/sau în locul lor por fi create subiecte personale.  
Introducem categoria itemului. Pentru a introduce o parte din itemi într-o categorie, trebuie ca înaintea 

primului item din categorie să se creeze un item binar cu răspuns corect, în care să se scrie ca enunţ numele 
categoriei în format GIFT de genul:  
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$CATEGORY: [numele categoriei] 
Dacă categoriile sunt ierarhizate, atunci ele se despart prin semnul „/”: 
$CATEGORY: [numele categoriei de nivelul 1] / [numele categoriei de nivelul II cu o ierarhie mai joasă] 

/ [etc.]. 
După instalarea corectă a şablonului, sub bara cu meniuri va apărea un panou cu instrumente speciale 

(Fig.1, linia a treia de sus): 
 

 
Fig.1. Panoul cu instrumente speciale ale şablonului GIFT. 

Dacă nu vedeţi acest panou, asiguraţi-vă că aţi deschis fişierul „GIFTTemplate.doc”. Dacă este deschis 
acest fişier şi panoul tot nu se afişează, pentru a-l afişa, se apasă butonul drept oriunde în panourile cu instru-
mente, după care, în lista afişată, se bifează opţiunea „Moodle”. Variantele de itemi se selectează în meniul 

 (Fig.2).  
Tot în această casetă sunt plasate şi butoanele de verificare a itemilor culeşi (Проверить) şi de convertire 

în format GIFT (Экспортировать) pentru încărcarea în Moodle. 
Pentru a uşura căutarea itemilor după tipul lor, se recomandă a folosi anumite coduri în numele itemului. 

Totodată, aceste coduri sunt utile pentru generarea monitorizată a testelor din itemii incluşi în colecţii cu 
ajutorul expresiilor regulate. 

 
 

Tipuri de itemi susţinuţi de şablonul GIFT:   
• cu răspuns  multiplu – cod M;  
• cu răspuns  singular – cod S;   
• binari – cod B, afirmaţii adevărate sau false;  
• cu răspuns scurt sau cuvinte  omise  – cod L;   
• cu răspuns sub formă de  valori numerice – cod N;   
• cu sortare/ordonare de elemente– cod O;  
• cu coordonare de elemente –  cod C;  
• de tip eseu –  cod E.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.2. Caseta de selectare a tipului de item. 
 
Structura codului itemului suficientă pentru generarea monitorizată a testelor este prezentată în Figura 3. 

Punctajul 1 poate fi omis în codul itemului (P9 în Fig.3 poate lipsi). 
   X   A      9 9 9      P 9  

N
Punctaj de la 1 la 5 
Numărul itemului în cadrul tipului 
Tipul itemului B, S, M, C, O, N, I, L, E 
Codul temei/colecţiei, 1-9 sau A, B, C, D etc. 

Fig.3. Structura codului itemului. 
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Cu şablonul special GIFTTemplate.dot este posibilă specificarea numelui (codului) itemului ::Nume::, 
pentru ca doar el să se afişeze în lista itemilor încărcaţi în Moodle. Însă, acest lucru este mai puţin recomandat, 
deoarece îngreunează editarea în Moodle. 

În cazul în care numele nu este specificat, acesta se formează din însuşi enunţul itemului de la început 
până la semnul «?», sau primele 100 de caractere. În lipsa unei experienţe, este recomandat numele din 100 
caractere, din care buteţi extrage/înţelege mai multe informaţii, care conţin la început şi codul.  

Opţiunile [no_shuffle] şi [shuffle] în parantezele pătrate pot fi doar la începutul itemului, respectiv pentru 
a dezactiva sau a activa modul de amestecare a răspunsurilor în itemii cu răspunsuri singulare, multiple, coor-
donare, corespundere. Implicit, este setat [shuffle]. 

Implicit, punctajul itemului este 1, şi poate fi omis. În caz contrar, un alt punctaj se introduce între paran-
teze pătrate la începutul itemului, sau după [shuffle]/[nu_shuffle].  

Ultimele două opţiuni se introduc înaintea codului/numelui, altfel şablonul nu le va interpreta corect. De 
exemplu: 

[shuffle] [3] 1M012P3. Prezentul item are primele trei variante corecte şi ultimele două incorecte, 
care la afişare se vor mixa. 
• [shuffle] – indică necesitatea mixării variantelor. 
• [3] – indică punctajul atribuit. 

rarea monitorizată de teste. • 1M012P3 – este un cod arbitrar ulterior utilizat la gene
o Codul itemului poate fi introdus înaintea punctajului.  
o Punctajul poate fi atribuit şi la finele enunţului itemului.  
Pentru a introduce o imagine în enunţ şi/sau în variantele de răspuns, se procedează în mod obişnuit: se 

deschide imaginea, apoi prin Ctrl+c se copie în Clipboard, se instalează cursorul în locul dorit şi se tastează 
Ctrl+v. 

3. Recomandări generale de redactare  
• Fiecare item va avea un cod (Fig.3), ce permite generarea ulterioară monitorizată a testelor. 
• Itemii se vor culege consecutiv/se vor grupa după tip/cod, ce permite administrarea şi modificarea facilă.  
 Adăugarea unui item nou se face în ordinea: instalare cursor în locul introducerii, selectarea tipului 

itemului din meniul 
•

 (Fig.2) şi culegerea textului. O altă alternativă este copierea unui item 
i editarea lui. apropiat, de tipul dorit, în locul dorit ş

Pentru mau multe detalii a se vedea [2]. 
Pentru comoditatea redactării, răspunsurile corecte în itemi binari, cu răspuns multiplu sau singular sunt 

afi  culoare roşie.  şate cu culoare verde, iar cele incorecte – de
Fiecare răspuns se introduce din rând nou. 
Schimbarea statutului din răspuns corect în greşit, şi invers, se face folosind butonul .  
După introducerea tuturor variantelor de răspuns este necesară ponderarea lor prin coeficienţi pozitivi 

pentru fiecare răspuns corect şi negativi pentru fiecare răspuns greşit. Introducerea coeficienţilor se face 
automat prin plasarea cursorului în textul itemului şi click pe . Ulterior, valorile numerice se 
pot modifica, însă suma valorilor pozitive trebuie să fie strict egală cu 100%. Suma ponderilor răspunsurilor 
negative poate diferi de 100%. Dacă este mai mare, atunci scorul itemului se va egala cu zero. Acesta este 
util pentru a contracara „ghicirea” răspunsurilor. 

Pentru a elimina ponderile tuturor variantelor, se plasează cursorul în textul itemului şi se activează buto-
nul .  

Note: 
 Neatribuirea ponderilor variantelor unui item cu răspuns singular sau multiplu duce la interpretarea 

eronată a itemului. 
 Efectuaţi atent corectarea manuală a ponderilor, încât introducerea unor valori care nu sunt rezervate în 

Moodle produce erori la importare. 
 Cu cât mai mare este numărul şi suma ponderilor variantelor incorecte (cu pondere negativă), cu atât 

mai mare este obiectivitatea itemului. Evident, în limitele raţionale al numărului de variante. 
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La redactarea itemilor cu ordonarea răspunsurilor sau potrivirea variantelor se creează două liste: din 
stânga şi din dreapta, fiind evidenţiate prin culori. Fiecare din liste trebuie să conţină cel puţin două-trei elemente, 
nu mai mult de 10, în funcţie de scopul urmărit. Elementele listelor trebuie să fie cât mai scurte. În mod ideal, 
lista din stânga poate să conţină numere de ordine şi/sau unul-trei cuvinte. Trecerea de la un element la altul 
se face prin apăsarea tastei Enter.  

Pentru studenţi se va afişa lista din stânga, cu posibilităţi de selectare a răspunsului potrivit din lista afişată 
în partea dreaptă.  

În general, pentru o mai mare obiectivitate, numărul variantelor în lista din dreapta poate fi mai mare decât 
cel al elementelor listei din stânga A. 

Itemii de tipul Răspuns scurt ( ) şi Numeric sunt semănătoare cu Răspuns multiplu. Ele 
la fel pot avea mai multe variante de răspunsuri cu pondere diferită, însă toate răspunsurile trebuie să fie corecte.  

La redactarea unui item numeric, partea întreagă se separă de cea zecimală prin punct, nu prin virgulă. 
Şablonul nu suportă diapazonul răspunsurilor corecte, în acest caz fiind necesară corectarea după importarea 
itemilor în Moodle. 

Itemul de tip Cuvânt lipsă este o variantă de întrebare cu răspuns scurt. Însă, acesta este mai comod, deoarece 
nemijlocit în item se conţine şi răspunsul. Pentru a redacta un item cu cuvânt lipsă, se selectează pictograma 

, se introduce textul itemului, după care să selectează un cuvânt şi se dă clic pe 
opţiunea de meniu . Ca rezultat, în loc de cuvântul marcat studenţii vor vedea pe ecran caractere 
de subliniere şi sarcina lor va fi să introducă corect cuvântul omis din frază.  

Notă. În acest tip de întrebare poate fi marcat ca răspuns doar un singur cuvânt, dar în realitate există 
mai multe cuvinte sinonime. În aşa caz, cuvintele se despart prin semnul egalităţii, iar marcarea se va face 
cu ajutorul Format painter  etc. Dacă apar erori la importare, ele pot fi corectate nemijlocit în codul 
GIFT generat de şablon şi repetată importarea. 

În itemii de tipurile S, M, N, L, pentru fiecare variantă de răspuns profesorul are posibilitatea să introducă 
câte un comentariu care se va afişa studentului la alegerea acestei variante de răspuns. Pentru a adăuga un co-
mentariu, se plasează cursorul în linia răspunsului dorit, apoi se dă click pe .  

[3][no_shuffle] M001P4. Orice reţea locală are la bază una din Topologiile elementare: 
• 33.333%Magistrală 
• 33.333%Inel 
• 33.333%Stea 
o -50%Plasa arbitrară 

Oare plasaă este o construcţie elementară? 
o -50%Completă 

Topologia când fiecare este legat cu toţi şi cu fiecare este una complexă. 
o -50%Mixtă  

O topologie mixtă constă din combinarea a câtorva topologii elementare. 
Note: 

 Dacă înaintea itemilor nu se introduce numele categoriei, itemii se vor importa în categoria implicită a 
cursului. 

 Dacă categoria deja există şi se introduce din nou, ea se va repeta şi, pentru corectitudinea colecţiei, ar 
trebui eliminată.  

4. Convertirea itemilor în format GIFT şi importarea în Moodle 
Pentru a verifica corectitudinea introducerii itemilor, din meniul  se alege . Dacă 

sunt erori – ele trebuie corectate.  
Înainte de a converti itemii din format MS Word în format GIFT, se recomandă şi verificarea vizuală a 

corectitudinii acestora: dacă sunt numerotaţi, dacă sunt utilizate doar stilurile admise de şablon etc.  
Pentru vizualizarea stilurilor se alege View → Normal. Dacă stilurile nu se afişează, atunci setăm Tools 

→ Options → View şi în câmpul  se setează o valoare diferită de zero, de exemplu 3 cm, 
după care se apasă OK.  

 90



Seria “{tiin\e exacte [i economice” 
Informatic= ISSN 1857-2073 

 După verificare se salvează fişierul, apoi se exportă/converteşte din format MS Word în format GIFTT 
prin activarea opţiunii  din meniul . După transformare se va deschide automat o 
fereastră de salvare a itemilor convertiţi. Rezultatul trebuie salvat în formatul „.txt” şi arhivat cu ZIP. După 
acceptarea numelui şi locului de salvare se activează butonul de salvare.  

Fişierul-text salvat poate fi, de asemenea, verificat vizual şi corectat manual, dacă apar erori la importarea 
lui în Moodle.  

 Succesiunea operaţiilor de importare în MOODLE: 
1. Se intră în curs şi se activează butonul  din meniul Administrare; 

2. Se alege tab-ul „Import” ; 
3. Se selectează opţiunea „GIFTformat with images” şi se apasă butonul „Continuare” ; 
4. În caseta afişată:  
• Se alege categoria în care vor fi introduşi itemi, dacă nu este indicată în fişier. Dar, totuşi, este mai 

recomandată indicarea categoriei în fişierul cu itemi. 
• În câmpul „Match Grades” se indică dacă se vor afişa erorile de punctaj sau dacă ele se vor transforma 

în ceva apropiat. Ultima opţiune trebuie utilizată cu mare precauţie, deoarece itemii pot fi deterioraţi, 
ceea ce impune o verificare totală a itemilor importaţi şi corecturi cheltuitoare de timp.  

• În câmpul „Stop on Error” se indică dacă procesul de importare se va opri la depistarea erorilor. Se 
recomandă oprirea la erori, corectarea lor şi repetarea procesului, până când toate erorile vor fi corectate.  

• În câmpul „Select directory for images” se indică directoriul unde se vor salva imaginile. 
• În câmpul „Prefix for Images” se specifică prefixul atribuit imaginilor, pentru eventuale administrări 

manuale. Dacă în test nu sunt imagini, în acest câmp se lasă locul gol. 
• În câmpul „Încarcă” se apasă butonul „Răsfoire” după care se face click pe „Open” a arhivei cu itemii. 
• Şi, în final, se apasă butonul „Încarcă acest fişier”. 

Dacă nu vor fi găsite erori, în următoarea fereastră se vor prezenta toţi itemii pentru importare. Se apasă 
butonul „Continuă” şi, ca rezultat, itemii se vor plasa în categoriile respective. 

Notă: În unele cazuri, Moodle poate să depisteze erori care nu sunt vizibile, greu de determinat, dar 
itemii trebuie urgent încărcaţi în Moodle. În aşa cazuri, se recomandă ignorarea erorilor de punctaj (în 
câmpul „Match Grades” se selectează „Nearest grade if not listed”) şi oprirea procesului de încărcare, în 
caz de erori setând „Nu” în câmpul „Stop on error”. După încărcare se pot consulta itemii şi determina 
eroarea, cu repetarea procesului după înlăturarea erorilor. 

5. Descărcarea şi instalarea şablonului GIFTTemplate.dot 
Se poate efectua pe orice calculator pe care este instalată una din versiunile MS Word 2003 sau 2007, ver-

siunile engleză, romană, rusă.  
Şablonul fişierului poate fi descărcat de pe site-ul moodle.org [1]. Arhiva şablonului se salvează pe calcu-

latorul personal, se dezarhivează, după care se execută fişierul Setup MoodleGIFT.exe şi se vor urma indica-
ţiile programului. 

Fişierul executabil va instala şablonul şi un fişier informativ pe discul C:, precum şi un arhivator în 
directoriul Windows. În meniul Start se va crea grupul «ДО» (abreviere din limba rusă – Дистанционное 
Образование) şi pe desktop va apărea fişierul GIFTTemplate.doc. 

După instalare este necesară setarea nivelului de securitate a sistemului. 
Atunci când se deschide un fişier ce conţine macrocomenzi/macro (în engl.: macros), utilizatorului i se 

afişează un mesaj de avertizare, pentru că acestea sunt programe, dar printre ele pot fi şi viruşi. Dacă utilizatorul 
nu este sigur, macro-urile pot fi oprite. 

În acest şablon macro-urile verifică prezenţa elementelor obligatorii ale itemilor şi generează codul GIFT 
la exportare. Deci, deschizând fişiere cu şablonul GIFT, macro-urile trebuie activate. 

Aceasta se obţine prin schimbarea nivelului de securitate a macro-urilor: 
• În versiunea engleză Word 2003 XP: Tools> Macro> Security>Medium> OK.  
• În versiunea engleză Word 2007: Butonul office>Word options> Trust Center> Trust Center Settings> 

Macro Settings>Disable all macros with notification>OK.  
• În versiunea rusă Word 2003 XP: Сервис>Макрос>Безопасность>Средняя> ОК.  
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• În versiunea rusă Word 2007: Butonul office>Параметры Word>Центр управления безопасностью> 
Параметры центра управления безопасностью> Отключить все макросы с уведомлением>OK 

Pentru ca opţiunea setată să se activeze, documentul dat se închide şi se deschide din nou. 
După instalare poate fi lansat un mini-videocurs de utilizare a şablonului Help_for_Using_Template.exe. 

Pentru mau multe detalii a se vedea şi [1-3]. 
 
Concluzii 
Pentru pregătirea comodă, eficientă, rapidă a itemilor, instrumentul GIFTTemplate.dot este decisiv. Această 

tehnologie de dezvoltare/actualizare a colecţiilor de itemi în MS Word oferă avantaje şi economii net superioare 
faţă de introducerea elementară direct în Moodle. 

Dar, şablonul mai poate fi îmbunătăţit. Mai întâi – prin eliminarea erorilor observate, mai ales la introdu-
cerea itemilor cu cuvinte-lipsă. Apoi – prin adăugarea unor noi tipuri de itemi (incluşi) şi desăvârşirea logicii 
de depistare a erorilor.  

Oricum, chiar în condiţii de existenţă a unor erori logice în şablon, el este deosebit de util şi ajută mult ela-
boratorii de itemi.  
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